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Introduction 

We recognize the diversity of our community and the importance of fostering 
inclusive community life. We are dedicated to ensuring that all people have 
equal opportunity to access and benefit from all public information and 
communications produced by or on behalf of the City as easily and as 
independently as possible. 

The Accessibility for Ontarians with Disabilities Act, 2005 (A O D A) is 
provincial legislation intended to develop communities that are free from 
discrimination and barriers to inclusion. Under the A O D A, the Information 
and Communication Standard of the Integrated Accessibility Standards 
Regulation outlines specific requirements we must achieve in this area.  

To reflect our commitment to our community, we have adopted an 
Information and Communication Standards Policy to take ownership of our 
responsibilities. This guide supports the standards and goals laid out in our 
policy and outlines our expectations for information and communications 
produced by or on behalf of the City. 
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Statement of Commitment 

The City of Belleville is committed to excellence and 
openness in local government by ensuring accessible and 
responsive representation. 

To this end, we will ensure our public information and 
communications are in accessible formats to provide all 
people with equal opportunity to access, obtain, and benefit 
from our goods, services, programs, and facilities. 
Furthermore, we will provide notice that alternate formats or 
communication supports are available upon request. 

 

Part One: General Standards 

As of 2020, 1 in 7 people in Ontario are living with a disability. This 
number will continue to rise as our population ages. 

Creating accessible information and communications will allow equal 
opportunity for everyone to access and benefit from our goods, services, 
programs, and facilities with dignity and as easily and independently as 
possible. 

Keep these general standards in mind when creating or procuring both 
printed and web content information and communications. 
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Language 

Requirement: Use plain language that is clear and concise. Aim for a 
grade eight or nine reading level. 

Plain language gives the reader a chance to process your information quickly 
and easily. It does not mean over-simplifying your message, it means 
making it easier to understand for a wider audience. 

Plain Language Tips

• Avoid symbols, legal terms, and 
word jargon 

• Use short, simple sentence 
structure and grammar 

• Use common words 

• Eliminate unnecessary wording 

• Consider your audience and be direct 
with your message 

• Use the active voice 

• Introduce and properly identify any 
acronyms 
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Caption: A cartoon of a man feeding a lengthy 
document into a boiling pot, while a woman 
holding a short document says “and this is 
what it will boil down to”

Note! If achieving plain language is not realistic due to the nature of your 
information, give clear notice that alternate formats or communication 
supports are available upon request. 

Microsoft Word uses the Flesch Reading Ease (F R E) to judge the readability 
of a document. It is a good guideline to keep in mind. 

 A score between 60 and 69 is acceptable, 70 or above is ideal 

The full F R E scoring is as follows: 

→ 00.0 to 29.9 = very difficult, college or university graduate level 

→ 30.0 to 49.9 = difficult, college or university level 

→ 50.0 to 59.9 = hard, grade 10 to 12 level 

→ 60.0 to 69.9 = plain language, grade 8 or 9 level 

→ 70.0 to 79.9 = easy, grade 7 level 

→ 80.0 to 89.9 = very easy, grade 6 level 

→ 90.0 to 100. = simple, grade 5 level 

Plain language example

Original (taken from our old website) 
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• F R E score = 30.4, difficult (college or university) 

It is important that you shall read the notes, advice, and information 
detailed opposite then complete the form overleaf (all sections) prior to its 
immediate return to Council by way of the envelop provided. 

Plain Language 

• F R E score = 87.2, very easy (grade 6) 

Please read the notes before you fill in the form. Be sure to complete all 
sections, then use the envelop to send it back to us as soon as possible. 

Note! In earlier versions of Word, it is possible to select certain 
sentences or paragraphs of text to check readability for only that 
specific text. 

Unfortunately, at the time this document was created, that option does 
not exist for Office 365. Office 365 will always check the full document, 
so it is a good idea check your readability frequently as you go. 

How to check readability in earlier versions of Word 

1. In the top task bar, go to the “Review” tab 

2. In the “Proofing” section, select “Spelling and Grammar” 

3. After reviewing any spelling and grammar edits, a pop-up box will appear 
with your word counts and readability statistics 

 If your readability statistics are not showing you may need to enable it 

1. In the top task bar, go to the “File” tab 

2. From the list on the left select “Options” and a pop-up box will appear 

3. In the pop-up box, from the list on the left select “Proofing” 

4. In the third section about spelling and grammar options, check the box 
for “show readability statistics” and hit “Ok” in the bottom right corner 
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How to check readability in Office 365 

1. In the “Home” tab of the top task bar, in the last section on the far right, 
open the “Editor” 

2. A panel will appear on the right side of your document, review any 
spelling and grammar suggestions 

3. When you have checked all spelling and grammar suggestions the word 
count and readability statistics pop-up box will appear 

 If the pop-up box does not appear you may need to enable it 

1. In the “Editor” panel on the right side of your document, at the very 
bottom of the list open the “Settings”   

2. A “Word Options” pop-up box will appear, from the list on the left select 
“Proofing” 

3. In the third section about spelling and grammar options, check the box 
for “show readability statistics” and hit “Ok” in the bottom right corner 

Text 

Requirement 1 of 2: Use sans serif fonts. 

Requirement 2 of 2: Font size must be appropriate in relation to its 
use and at minimum Arial 12 point or visually equivalent to it. 

Text Font 

What are sans serif fonts? They are font styles that do not have extending or 
decorative flares on any letter strokes.
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Examples of serif fonts: 

Times New Roman, 

Lucida Handwriting 

Examples of sans serif fonts: 

Arial, Verdana, Calibri

 Sans serif fonts have easily recognizable upper and lower case letter 
formations and numerical characters 

 Using these fonts will contribute to the readability of your information 

 
Caption: Written in a decorative font, the image reads, “Imagine trying to 
read a novel written in a font like this one! It’s taxing to read be because 
the brain has to strain to recognize the words and characters.” 

Text Size 

Text size must be at minimum Arial 12 point or a visually equivalent. Choose 
font sizes that are appropriate for the purpose of the text.

For example: 

Body text = 12 point 

Headings = 14 point 

When determining appropriate text sizes 
consider: 

• the purpose of the text 

• format and delivery 
method of the 
information 

• your intended audience 
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Text size can differ in appearance depending on the font you choose. 
Remember this when selecting the appropriate text font and size. 

For example, compare: Calibri font size 12 

Arial font size 12 

Verdana font size 12 

Note: When creating large print formats use a font size of 16 or 18, unless 
otherwise requested.

 

 

 

 

 

Caption: A cartoon man uses a magnifying 
glass to read fine print on a comically small 
piece of paper. 
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Reader Friendly Information 

Requirement 1 of 1: Create readable text by using clear and 
organized text and pre-set document style options. 

Creating Readable Information 

• Avoid italics  italic print is angled and often more narrow than other 
fonts making it harder to read 

• Avoid underlining  underlining can interfere with lower case letters and 
word shapes making it harder to read. Use only when necessary, like to 
indicate a link 

o Tip! Try using a bottom border. It will give you the same visual look 
but appear fully below all text lines, so it does not interfere with 
lower case letter strokes and word shapes. 

Underline example Bottom border example 

• To make text stand out use an exclamation mark!, increase the size, 
or use bold 

• Do not bold full paragraphs. Only use bold to make specific text stand 
out, and try limit it to 5 words in a row  

• Avoid busy background designs 

• Avoid using all UPPER CASE  using standard combinations of upper 
and lower case letters provides word shapes that can give clues to our 
brains. This can make processing time faster and easier for the reader 
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Margins 

• Use one-inch margins for an 8.5 by 11 page size. A minimum margin of 
0.5 inches is also acceptable. This promotes readability and is ideal for 
readers who may use magnifiers 

Alignment 

• Always align text to the left margin. This makes it easier for readers to 
find the start of the next line, keeps the spacing between words even, 
and is more visually appealing 

Did you know? Center alignment is more difficult for your eye to track. It 
causes uneven indentations and can make it difficult for readers to find the 

start of the next line. Especially for people with vision loss, learning 
disabilities, or using a magnifier, center alignment makes it challenging to 

follow along with the text. 

Did you know? Justified text creates larger and uneven spacing between 
words. The irregular spacing means your eye jumps from word-to-word, 
instead of flowing continuously along the sentence. This can slow down 
processing and make it more difficult to read and understand the content. 

Note! It is acceptable to center a document title, heading level, and 
short (one or two) lines of text. 

  

If you want your 
message to reach your 
intended audience and 
be effective, make it 
readable! 
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Line Height 

Line height, known as leading (pronounced “ledding”), is the amount of 
space between the lines of text in a paragraph. It is calculated automatically 
using a percentage or decimal of the text font and size you choose. 

For example: for a font size of 12 pt, single line spacing would be written as 
100% or 1.00, and one and half line spacing would be written as 150% or 
1.50. 

Ideal leading for readability is between 125% to 150%. The 
appropriate leading for your content will depend on the font you choose. 
Some fonts have larger letter formations and will benefit from a larger line 
height. 

Although not commonly focused on, setting the appropriate leading for your 
document has a significant impact on readability. Consider the following: 

 12pt Arial font with single line spacing 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Proin fringilla felis et 
ullamcorper egestas. Vestibulum magna mi, mollis id rhoncus eu, elementum nec 
purus. Maecenas nibh elit, viverra a tristique et, laoreet vel tortor. Duis orci quam, 
vestibulum quis turpis vel, hendrerit sagittis nibh. Mauris viverra mauris ut enim pretium, 
non hendrerit quam laoreet. 

 12pt Arial font with 1.25 line spacing 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Proin fringilla felis et 
ullamcorper egestas. Vestibulum magna mi, mollis id rhoncus eu, elementum nec 
purus. Maecenas nibh elit, viverra a tristique et, laoreet vel tortor. Duis orci quam, 
vestibulum quis turpis vel, hendrerit sagittis nibh. Mauris viverra mauris ut enim pretium, 
non hendrerit quam laoreet. 

 12 pt Arial font with 1.50 line spacing 

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Proin fringilla felis et 

ullamcorper egestas. Vestibulum magna mi, mollis id rhoncus eu, elementum nec 

purus. Maecenas nibh elit, viverra a tristique et, laoreet vel tortor. Duis orci quam, 

vestibulum quis turpis vel, hendrerit sagittis nibh. Mauris viverra mauris ut enim pretium, 

non hendrerit quam laoreet. 
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 Use a minimum 1.25 line height for any public information or 
communications 

Use 1.50 line height for any requested alternate 
accessible formats, unless otherwise specified 

Setting Line Height 

You can use your “Paragraph” tools to set line height on demand or, better 
yet, format your “Normal” document style so that the line height is set for all 
body text in your document. 

1. Choose one of three options: 

1a.  From the task bar, in the “Paragraph” section, use the “Line and 
Paragraph Spacing” drop down menu to select “Line Spacing Options” 

OR 

1b.  Right click anywhere on the page in your document and from the pop-
up menu select “Paragraph” 

OR 

1c.  From the task bar, in the “Styles” section, right click over the style 
“Normal” and from the pop-up menu select “Modify”. A “Modify Style” 
pop-up box will appear. In the bottom left corner of the pop-up box use 
the “Format” drop-down menu to select “Paragraph” 

2. No matter which first step you follow, they will all result in the 
“Paragraph” pop-up box. On the first tab for “Indents and Spacing”, in the 
third section “Spacing” use the “At:” field to enter your desired line height 
between 1.25 (minimum) to 2.00 (double spacing). 

3. Click “Okay” in the bottom right corner of the pop-up box to set the line 
spacing. If you started with method 1a or 1b the formatting will only 
apply to the specific text highlighted 
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Tips for Organizing Text 

Caption: The woman on the 
left is stressed and confused 
trying to read a full page of solid 
text. The woman on the right is 
happy as she easily reads her 
page because the author used 
readable and organized text 
practices like headings, short 
paragraphs, bullet lists, and 
images. 

 

Your message doesn’t matter if they can’t or don’t want to read it! 

Without clear content organization your reader or audience could quickly 
become confused, overwhelmed, and disinterested in the information. 

The way you structure your content helps people to stay focused and quickly 
and easily follow along, interpret the information, make connections about 
your message, and understand its purpose. 

• Use columns  can help break up lengthy text

• Align text to the left margin  makes it easier to find the start of the next 
line and keeps the spacing between words even 

• Use bullets points and lists  can break up lengthy text and promote 
readability by being more direct 

• Use images  conveys spirit or meaning 

• Use appropriate headings  organizes your content 

• Aim for short paragraphs  convey only one or two related thoughts or 
points of information. 

Organization and presentation of your content 

is just as important as your actual information.
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Colour 

Requirement 1 of 2: The contrast ratio between any text or content 
element and its background must be at least 5:1. 

Requirement 2 of 2: Do not use colour alone to convey a message, 
there must be another identifying feature.

What is a Contrast Ratio?

A contrast ratio refers to the noticeable difference between the brightness of 
any two colours. Brightness difference can range from 1 to 21. A contrast 
ratio is always written so that 1 represents the “lighter” colour between the 
two that you are comparing. 

  

 

What do you see in the graphic on the left? 

Some people might only see a shaded circle, some 
might see a circle of dots, others might see the 
number 74, and still others might see the number 
21. This is an example of how we can perceive 
colour differently.

 
 
 

good 
(contrast 11.2:1) 

 
 
 

colour 
(contrast 19.6:1) 

 
 
 

contrast 
(contrast 8.9:1) 

 
 
 

bad 
(contrast 3.2:1) 

 
 
 

colour 
(contrast 2.7:1) 

 
 
 

contrast 
(contrast 4.0:1) 
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Colour is a great way to enhance your content. It can help attract attention, 
convey meaning, represent importance, and be visually appealing. 
However, all people see colour a little differently. If you are not careful with 
your colour choices it can significantly impact reading and comprehension, 
especially for those living with a colour vision deficiency. 

Did you know? 

Colour Vision Deficiency (CVD) is the inability to distinguish some colours or 
shades from each other. Colour Blindness means the person cannot identify 
any colour at all. 

Colour Blindness is very rare, but CVD is actually quite common. CVD is 
more common in males, with 1 in 10 men having some type of CVD and only 
1 in 200 women.

 

Use colour appropriately! Consider your content, your message, 
your audience, and the end format of your information or 
communication. 

Do not use colour alone to convey a message! In graphic elements such as 
graphs or charts, always use a second identifying feature other than colour 
to help readers differentiate and interpret information.

Figure 1 = Good 
This graph is reader friendly because it 
uses colour and patterns to differentiate 
information 

 

Figure 2 = Bad 
This graph would be difficult to interpret for 
readers who have some form of CVD 

Sales 1st Qtr

2nd Qtr

3rd Qtr

4th Qtr

Sales 1st Qtr

2nd Qtr

3rd Qtr

4th Qtr
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 There are many options for colour combinations! A great way to 
determine contrast ratios is to use a free online colour contrast checker. 

Using the Colour Contrast Analyzer 

1. Use the link above to the download the colour contrast analyser  

2. Use the eye dropper in the first section to select the foreground colour. 

3. After clicking on the eye dropper icon, you will notice your mouse turns 
into a small dot with a magnified view of the surrounding content. Drag 
the dot over the first colour you want to compare and click to select it. 

4. Use the eye dropper tool in the second section to select the background 
colour. 

5. The colour contrast checker will automatically calculate the contrast ratio 
between the two selected colours. It will also tell you if you have passed 
the colour contrast requirements of the Web Content Accessibility 
Guidelines (WCAG), which is an AODA requirement. 

 

4 

2 

4 3 

5 

https://developer.paciellogroup.com/resources/contrastanalyser/
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Part Two: Format and Structure 

 

It is important to format and structure your document using the pre-
programmed options and settings. This helps organize your content 
and makes your document compatible with assistive technologies. 

Tip! Take the time to structure your source document properly, 
such as in Word, PowerPoint, or InDesign. This will assist you 
later when converting the document to PDF, HTML, or other 
accessible formats. 
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Formatting your Content 

Requirement: Use pre-programmed functions to format your 
document. 

Paragraph Formatting 

Almost all paragraph-formatting options are under the “Home” tab in the top 
task bar, in the “paragraph” section. 

 

 

Top row icons from left to right: 

• create a bulleted list 
• create a numbered list 
• structure a multi-level list 
• decrease indent 
• increase indent 
• sort data 
• show / hide paragraph formatting 

Bottom row icons from left to right: 

• left alignment 
• center alignment 
• right alignment 
• justified alignment 
• line and paragraph spacing 
• shading options 
• border options
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You can also right click and access 
the paragraph-formatting options 
within a pop-up menu. 

 

Blank Spaces

Creating and managing blank space properly contributes to an organized 
document, but more importantly keeps your document reader friendly and 
compatible with assistive technologies. 

× Do not use “Enter” to create space between headings, body text, or 
paragraphs 

 Do use the “Line and Paragraph Spacing” options to add space above or 
below your headings, body text, or paragraphs 

× Do not use the “Space Bar” or “Tab” multiple times to indent lines 

 Do use the “Increase Indent” or “Decrease Indent” options to adjust 
where the line starts 

× Do not use the “Space bar” or “Enter” repeatedly to force text onto a 
new page 

 Do use the “Page Break” function (in the “Pages” section of the “Insert” 
tab) to move content onto a new page 
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Did you know? If you create blank space by using “Enter”, “Space 
bar”, or “Tab” a screen reader will read out “blank space, blank space, 
blank space….” This is a great example of why it is important to use 
proper formatting options to create readable and accessible documents.

 

Lists 

When creating a list, be sure to format a real list by using the built-in 
formatting options. List options are in the “Home” tab of the top task bar, in 
the “Paragraph” section.

 
Figure 1: Bulleted Lists 

 
Figure 2: Numbered Lists 

 
Figure 3: Multi-level Lists

 Use bullets for listing standard information 

 Only use a numbered list if you need to convey an order or count of your 
information 

Formatting proper lists is important for compatibility with assistive 
technologies. If you make your list manually by typing in numbers or bullets 
a screen reader cannot identify the list structure, and some of the meaning 
and relationship between content will be lost. 
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Given careful attention to how you structure any multi-level lists. This will 
maintain compatibility with assistive technologies and ensure you are 
conveying the relationship between information. 

Remember! Structuring lists properly in your source document will assist 
you later when converting your document to another format like P D F. 

 

Abbreviations 

An abbreviation is a shortened form of a word or term. You need to clearly 
identify them to keep your content reader friendly and compatible with 
assistive technologies. We will focus on three common types of 
abbreviations: acronyms, initialisms, and contractions and shortenings. 

Acronyms 

 Uses the first letter of each word in a term to create a new word 

 Pronounced phonetically as word, do not use periods or spaces to 
separate the letters 

 Typically, every letter is capitalized 

Example: 

• “CAPTCHA” is a common acronym for “completely automated public 
turing test to tell computers and humans apart”. You want a screen 
reader to pronounce “CAPTCHA” as a word, not read out each letter 
individually, so do not use spaces or periods 

Initialisms 

 Uses the first letter of each word, but no new word is created 

 Use spaces or periods in between the letters so each one is read out 
individually 

 Typically, every letter is capitalized 

Example: 
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• “D I Y” is a common initialism for “do it yourself”. You want a screen 
reader to read out each letter individually as D - I - Y, not 
pronounce “diy” as a word 

Contractions and Shortenings 

 An abbreviation where you leave out some of the letters in a word to 
create a short form 

 Shortens the written word, but often you still pronounce the full word 
it represents when reading 

 Some common contractions and shortenings may have two meanings, 
so it is important to properly identify them 

 If the shortened version of the word is a real word itself that still 
conveys the proper meaning, it does not need to be identified as an 
abbreviation unless there is more than one possible interpretation 

 The first letter of a contraction or shortening is only capitalized if you 
would normally capitalize the full word 

Example: 

• “Dr” might be a contraction for “Doctor” or “Drive” 

• “apt” is a contraction for appointment 

• “Sat” is a shortening for “Saturday” 

• “app” might a shortening for “application” or “appetizer” 

• “info” is a shortening for “information” and is a real word that can 
still convey the full meaning. You would not need to identify it as an 
abbreviation. 

Identifying Abbreviations 

For acronyms and initialisms, always fully introduce the full word or term the 
first time you use it and include the corresponding abbreviation in brackets 
immediately following it. 

For contractions and shortenings, when converting your document to P D F 
add alternative text for the contraction or shortening so that the correct 
word or interpretation is read out properly by screen readers. 
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Formatting tip for initialisms: if you do not like the appearance of using a 
full space or periods between the letters of your initialism, there is a 
formatting adjustment you can use. 

1. In your document type your initialism without spaces, for example DIY 

2. In the “Home” tab of the top task bar, go to the “Editing” section (fourth 
in from the right side) and select “Replace” 

3. A pop-up box will appear. In the “Find what” bar, type your initialism 
without spaces as you did in your document 

4. In the “Replace with” bar type, your initialism again but this time use 
spaces (for example D I Y) 

5. With your cursor left in the “Replace with” bar, in the bottom left corner 
of the box click on the “More” button to expand the options 

6. Go to the “Format” menu in the bottom left of the expanded pop-up box 
and select “Font” 

7. A second “Font” pop-up box will appear, go to the second tab “Advanced” 

8. In the first section, from the “Spacing” drop down menu select 
“Condensed”. Directly beside this it says “By”, in the bar next it enter or 
use the arrows to set your condensed spacing to about 1.5pt and click 
“Okay” in the bottom right corner 

9. Finally click either “Replace” or “Replace All” and your initialism will 
reformat itself so that the letters appear close together, while maintaining 
a structural space so that it can be read out properly by screen readers 
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Structuring your Document 

Requirement: Use appropriate heading levels to structure your 
document 

Heading levels 

Heading levels are important to add structure, create logical reading order, 
and show relationships between your content 

• A heading should be descriptive, but short 

• Use heading levels in order without skipping a level, for example:

→ heading 1 = the title 

→ heading 2 = top level headings 

→ heading 3 = sub-section headings 

→ normal = body text 

 Throughout your document you 
may go from a “heading 3” back 
to a “heading 2”, but you cannot 
for example skip from a “heading 
1” to a “heading 3”

• Use appropriate headings frequently 
to break up long documents and 
organize your content 

• Do not select a heading level based 
on visual appearance. You can 
modify the appearance of the 
appropriate heading level as 
necessary 

• Text standards still apply such as 
font, size, and colour. Do not choose 
or create a heading style that go against these general requirements 
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Not sure how or when to use a heading level? 

Consider this example: say you have a textbook, 

 Heading level 1 (H1) = book title 

 Heading level 2 (H2) = chapter titles 

 Heading level 3 (H3) = titles of subsections within each chapter 

 Heading level 4 (H4) = the practice questions of a sub-section 

In the continued example below, notice how the heading levels add 
structure, relationship, and navigation to the content. Users of assistive 
technology depend on this to ensure their reading experience is logical, 
comprehensive, and user friendly. 

For example, a person using a screen reader can access a list of the heading 
level structure and jump directly to the content they want to read, without 
having to go scroll through a full document.  

(H1) Biology 101 

(H2) Chapter 1: Cells 

(H3) 1.1 Cell Structure and Function 

(H4) 1.1.1 Cell Structure and Function Practice Questions 

(H3) 1.2 Biological molecules 

(H3) 1.3 Cell Membranes 

(H4) 1.3.1 Cell Membrane Practice Questions 

(H2) Chapter 2: Genes 

(H3) 2.1 What are Genes 

(H4) 2.1.1 Genes Practice Questions 

(H3) 2.2 Genes and Hereditary Characteristics 
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Creating and modifying a heading level: 

1. Select the text you want to apply the heading level to 

2. In the “Home” tab of the top taskbar, in the “Styles” section, click on the 
appropriate heading level 

• You have now structured the highlighted text as the selected heading 
level 

3. To edit the style, hover your mouse over the desired heading level you 
want to edit, right click, and select “Modify” from the pop-up menu 

4. A dialog box will appear. Here you can set features such as text font, 
size, and colour 

5. By clicking “Format” in the bottom left corner of the dialog box you can 
modify other features such as “Paragraph” options (spacing) or “Borders” 

6. When you are finished making changes, click “Okay” in the bottom right 
corner of the dialog box. Changes will apply to all text that is designated 
as that heading level 

• If you want to change the appearance of only one heading, not all 
headings at that level, you can use your standard formatting options 

 
Caption: A screen shot on how to create a heading level, including the “Modify Style” 
pop-up box that allows you to edit the style or appearance of the heading level. 
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The Navigation Pane 

The navigation pane allows you to view and, if necessary, edit your 
document heading levels and reading order. Double check the navigation 
panel to ensure your document is properly structured.

How to check and reorder the navigation pane:

1. Select the “View” tab in the top taskbar 

2. In the “Show” section, check the box beside “Navigation Pane” and a panel 
will pop up on the left side of your document 

3. Check your heading levels and reading order. If your document is properly 
structured, all heading levels will been shown with lower heading levels 
nestled under the higher heading levels 

4. If the reading order is not correct 
you can move a heading by 
clicking on it and holding the 
click, then dragging the heading 
up or down the list and releasing 
the click to insert in the desired 
location 

5. If a heading is missing, go back 
through your content and format 
your titles and headings using the 
pre-programmed options. 
Especially for lengthy documents, 
make sure all important sections 
of your content are represented 
with heading levels 
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Table of Contents 

A table of contents makes it easier for readers to navigate large documents. 
Documents 10 pages or longer should have a table of contents. If you use 
proper heading levels, Word can automatically create a table of contents for 
you. 

How to create a table of contents: 

1. Open the “References” tab in the top task bar  

2. In the “Table of Contents” section, click on “Table of Contents” and a 
drop-down menu will appear 

3. Select “Insert Table of Contents” from the bottom of the drop-down menu 
and a dialog box will appear 

4. Using the options in the dialog box you can set the format and style for 
your table of contents including which heading levels you want to include, 
page numbers, and tab leaders 

4.1.  By selecting “Modify” in the bottom right of the dialog box, an 
additional dialog box will open which will allow you to edit text font, 
size, and spacing. When you are finished, click “Okay” in the bottom 
right corner to take you back to the main dialog box 

5. Click “Okay” in the bottom right corner of the main dialog box and the 
table of contents will automatically appear in your document 

6. To update the table of contents right click on the table and a pop up 
menu will appear. Select “Update Field” and a small dialog box will open. 
Choose to update page numbers or entire table and click “okay”. The 
table will update automatically 

Do not create a table of contents manually 

Table of Contents Best Practice 

o Do not choose a dot tab leader. Chose a straight line or chose to not 
have a tab leader  
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Images and Non-text Elements 

Requirement: All non-text elements need appropriate and 
descriptive alternative text.

Alternative Text 

Alternative text, or alt text, is a short written description that gives the 
reader the same information that the visual element represents. It should 
describe the element and the message, information, spirit, or function it is 
meant to convey. 

Do not skip or diminish the value of alt text 

Appropriate alt text: 

• ensures our websites and web content meet accessibility standards 

• makes our websites and web content more searchable 

• supports website function, particularly if it is slow to load, has difficulty 
displaying non-text elements, or when using mobile devices 

It is a simple concept that plays a very important role. It is especially 
important for users of assistive technologies, such as screen readers, since it 
provides visual information in an alternate format. 

Every non-text element must have alt text. Consider the context when 
determining appropriate alt text: how and why the element is used.

Never leave alt text blank 

Important Note! Null alt text = “” 

Null alt text signifies to assistive technology that it should skip over 
the element. Continue reading to learn when to use it.
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Adding Alt Text 

1. Select or place your cursor over 
the image or non-text element. 
Right click and from the pop-up 
menu select “Format Picture”  

2. The “Format Picture” box will 
pop-up, and from the options 
down the left side select “Alt 
Text”. It is the very last option 
in the list 

3. Enter a title and description, 
using null alt text if appropriate, 
and click “Close” in the bottom 
right corner of the box 

 

  Steps to add alt-text 
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Types of Elements & Appropriate Alt Text 

Informative Elements 

• Typically accompany body text to visually represent information, spirit, 
or emotion 

Example:

 

Appropriate alt text: 

Title: Belleville Pride Parade 

Description: people of all ages carry a large multi-coloured pride flag over 
their heads as they march through Zwicks Park as part of Belleville’s Pride 
Parade

 

Functional Elements 

• Signify an action such as a button, link, or other interactive feature 

• Alt text should describe the functionality rather than the visual image 

• Use null alt text if a functional element is accompanied by a caption or 
descriptive text

Example: this image is on our website as a functional link

 

Appropriate alt text: 

Title: Facebook 

Description: redirect to City of Belleville Facebook 
page
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 If this image had a caption that read “Facebook” or descriptive text 
saying “follow the City of Belleville on Facebook”, it would have been 
appropriate to use null alt text (“ ”) 

 

Images of / containing text 

• In general, avoid using text within images 

• If images of / containing text are present, use those words as part of 
the alt text 

• This does not exempt the element from also following any other 
applicable alt text rules. For example, if an informative photo has text 
within the image the alt text should convey both the intended message 
or spirit and any in-image text 

Example:

 

Appropriate alt text: 

Title: Belleville, a great place to visit 

Description: Diners on the patio of Myer’s Pier waterside restaurant look on 
as a rowers paddle a long boat down the Bay of Quinte

Decorative Elements 

• Only purpose is to add visual decoration to the page 

• Provide null alt text (“ ”) to signify that assistive technology can ignore 
or skip over the element  

• It is very important for compatibility with assistive technology that 
decorative elements are given null alt text and not simply left blank 

Example:
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Appropriate alt text = “ “

Grouped Elements 

• If multiple images or non-text elements convey a single piece of 
information, enter alt text for one element that conveys the information 
for the entire group  

• Use null alt text for the remaining elements of the group 

Example: A group of photos makes up the cover page for this brochure

 

Appropriate alt text for the 
first image: 

Title: Belleville Community Profile 2016 
Cover Page 

Description: Belleville highlights including a 
long boat of rowers pulling into Myers Pier 
Marina, fresh chocolate from Donini Chocolate 
Factory, the newly updated Via Rail train 
station, and a local woman shopping at the 
famers market. 

 The remainder of the images should have 
null alt text (“ ”)

Complex Elements 

• Used to convey data or detailed information, such as graphs, diagrams, 
and maps 

• Best practice is to describe the content of complex elements in the body 
text of your document or web content, making direct reference to the 
visual element 
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• If descriptive text is not included, insert a caption with a summary of 
the information that the visual element provides 

• Be sure to provide an accurate label or title for the element 

• If descriptive text or an appropriate caption is present, use null alt text 
(“ ”) 

Example: this complex element is a bar graph with no descriptive text 

Bar Graph: Dollar Value of Building Permits Issued Per Year 

 
Bar graph of building permits issued by dollar value per year between 2010 to 2015: 2010 
approximately $95 million, 2011 approximately $150 million, 2012 approximately $45 million, 
2013 approximately $70 million, 2014 approximately $65 million, and 2015 approximately $67 
million 

Appropriate alt text: 

Title: Dollar Value of Building Permits Issued Per Year 

Description: “ ” 

** Since there is an appropriate, descriptive title and caption for this graph, 
that provide equivalent information as the visual image, we can use null alt 
text  
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Using Tables, Charts, or Graphs: 

When using complex elements such as tables, charts, or graphs, keep your 
formatting simple so the information can be understood by a large audience. 
It is important to make sure these features are compatible with assistive 
technologies. 

• Keep tables simple and avoid merged cells  

• Identify a header row for tables. If a table runs across pages, format it 
so the header row shows at the top of each page 

• Do not use colour alone to convey or differentiate information. 
Remember to include more than one identifying element 

• Include a title that expresses the purpose of the data and be sure to 
identify the type of visual (example: chart, bar graph, table) 

• Provide descriptive text making reference to the visual element, or use 
a caption to explain information that is visually presented 

Note! For some complex elements, for example a financial document, it 
may not be possible to comply with all the above requirements. If you 
author such documents, you must clearly give notice that alternate formats 
or communication supports are available upon request. 
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Part Three: Municipal Website and Web Content 

The World Wide Web Consortium, known as W.3.C, wrote the Web Content 
Accessibility Guidelines (W.C.A.G). They are the internationally recognized 
standard for web and web content accessibility. The A O D A defers to the 
W.C.A.G 2.0 when setting requirements for accessible information and 
communications. 

This section outlines the basic accessibility expectations for web content 
authors. It does not cover every requirement of the W.C.A.G and how to 
meet them. If you require further training on W.C.A.G requirements please 
speak with your supervisor. 

In today’s society, people access many of our goods, services, and programs 
online. We need to ensure that people with disabilities have equal 
opportunity to access and benefit from them, with dignity and as 
independently as possible. 

 
A computer monitor surrounded by symbols representing various types of 
disabilities, to stress the importance of creating and maintaining accessible 
websites and web content. 

https://www.w3.org/TR/WCAG20/
https://www.w3.org/TR/WCAG20/
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Web Content 

Requirement 1 of 2: All web content must meet level AA 
criteria of the W.C.A.G 2.0. 

Requirement 2 of 2: Any documents posted to our municipal 
websites must be an accessible P D F. 

The general criterion for accessible information still applies. Always 
remember to consider features such as, 

• Text font and size 

• Plain language 

• Colour contrast 

• Format and structure 

• Images and non-text elements 

• Alt text 

 

A comic of an arm reaching out of a computer screen to 
shake a man’s hand, and the man turns to a woman and 
says, “I told you the site was user friendly”  



43 

Online Audio and Video 

Any of our public information or communications delivered through pre-
recorded audio and /or video media must also present information in an 
alternate format. 

• Prerecorded audio clips must have a text transcript 

• Prerecorded audio-video and video only clips must have captions 

Note: At the time this document was created, the A O D A provides 
exceptions for live captioning and prerecorded audio descriptions. This 
may change depending on updates to legislation. 

Depending on your information, audience, and delivery method, it may be 
appropriate to include additional communication supports.

Example 1: For a video from 
Mayor and Council regarding a 
public safety message, it may be 
appropriate to include sign 
language interpretation 

Example 2: If you are hosting a 
large conference, it may be 
appropriate to arrange for live 
captioning and sign language 
interpretation

 

Stop, Pause, Hide: For any media that flashes, scrolls, moves, 
auto-updates, or plays automatically, the user must have the option 
to stop, pause, and hide the content. 
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Hyperlinks and Link Text 

A hyperlink, or simply a link, allows you to jump from your current position 
on a web page or in an online document to another section, or a different 
web page or document. Link text is the clickable text that contains the link.  

You will find links on almost all websites and frequently used within web 
content documents. Making a link accessible and compatible with assistive 
technologies is a basic, but important aspect of web accessibility. 

Creating Accessible Links 

• Link text needs to be short, but descriptive. Never use “click here” 

• Never use a website address as link text 

• Links need to make sense when taken out of context. 

o Some users may choose to access a list of available links, especially 
if they know what they are searching for. Your link text needs to be 
descriptive so that its purpose or destination is clear even without 
the rest of your content 

• Do not include the words “link” or “link to”. Assistive technologies will 
indicate the presence of a link option to the user 

• Do not re-use link text. Each link should serve a unique purpose and 
have a specific function 

• Avoid redundant links. There is rarely a need to have two links on the 
same web page that perform the same function 

• Make sure you do not have any empty or broken links 

Web Developers: Ensure that the software or program you use will 
allow a person using keyboard navigation to find and activate links 

Example: 

Right  Access our Information and Communications Guide 

Wrong  To access our information and communications guide click here 

Wrong  Access our Guide: www.informationandcommunications/guide_123 

Wrong  Download our Guide 
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P D F and Accessibility 

P D F stands for portable document format. P D Fs are used for accessible web 
content because they can be opened on any operating system and will 
maintain their formatting. Additionally, P D F Reader is free, so the end user 
does not need to purchase a program or subscription to open your 
document. 

Note: All documents posted to our municipal websites must be an 
accessible P D F., including accessible fillable forms 

P D F Accessibility Checklist 

Tags 

• PDF has appropriate tags 

o no empty content tags 

o no redundant (double tagged content) 

o properly tagged lists, headings, paragraphs, images, and other non-
text elements with standard PDF tags 

o paragraph tags accurately represent any visual paragraphs 

o all text within tags is correctly formatted, as in free from line breaks 
and split words 

•  any text with added features intended to visually identify a heading is 
tagged with an appropriate heading tag (H1 through H6), starting with 
the descriptive document title tagged as an H1 

• heading tags follow a logical hierarchical progression (no skipped 
heading levels) 

• appropriate heading tags on text that defines a section of content 

• the heading text accurately describes the content 

• links are tagged correctly and included in the tag structure (contain 
link text and link OBJR within the link tag) and appropriate alt-text 

• all non-standard tags are appropriately mapped to standard PDF tags 
(for example “story” tags removed or modified) 
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• all informational content is contained in the tag structure 

• the order in the tag structure is accurate and logical. The tags match 
the order they should be read in 

Reading Order 

• reading order was manually reviewed and, if necessary, corrected 

Table of Contents 

• accurate bookmarks are provided for documents greater than 9 pages 

• table of contents is tagged with appropriate tags (TOC, TOC Item 
(TOCI)) 

• all TOC entries are functioning internal links (appropriate bookmarks) 

Colour 

• do not use colour alone to convey information. When using colour, 
include another identifying feature to convey information. For example 
use colour and pattern for graphs 

• all colour combinations meet the 5:1 colour contrast ratio between 
text and any other elements and their background 

Links 

• links or functional elements are distinguished by a method other than 
color 

• link text can be understood out of context 

Non-text Elements 

• all images conveying information are tagged as figures and included in 
the tag structure 

• all images conveying information have alt text that provides the same 
level of understanding a visual user would gain 

• all decorative images are tagged as artifact 

• provide equivalent information in an alternate, accessible format for 
any complex graphic elements (data graphs) 

• the document is free from images of text or information (such as 
scanned pictures, tables, or document text from another source) 
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• groups of related images are tagged in a way assistive technology 
users would understand 

Tables and Lists 

• use table tags only for data tables 

• the table structure in the tag tree matches the visual table layout 

• all header cells are tagged with the TH tag and all data cells are 
tagged with the TD tag 

• all Header cells contain text 

• merged cell properties are correctly spanned with Colspan and/or 
Rowspan 

• set column and row headers appropriately using scope  

• tables with more than 1 set of column and/or row headers 
appropriately use id/headers to associate to data cells 

• all visual lists are tagged correctly with the List, List Item (LI), and 
LBody tags 

• the number of items in the tag structure matches the number of items 
in the visual list 

• nested lists are appropriately nested in the tag structure (multi-level 
lists) 

General 

• document title is set in Document Properties 

• correct language of the document set 

• fonts are embedded 

• the document is free from content that flashes more than 3 times per 
second 

• text can be resized and still considered readable when magnified to 
200% 

• citations and footnotes / endnotes are tagged with appropriate tags 
(Reference, Note) 

• the PDF will pass a CommonLook validation against WCAG 2.0 level AA 
criteria 
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• Adobe has a built-in accessibility checker, however unfortunately it 
cannot provide a comprehensive review and is not a reliable measure 
of compliance with our web content responsibilities. All P D Fs need a 
manual review to ensure it is in an accessible and compliant format. 

•  

• Remember: The easiest way to create an accessible P D F is to start 
with an accessible source document (like Word, PowerPoint, Excel, or 
InDesign) 
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PDF Forms 

As much as possible, City staff should use our form builder tool to create 
online fillable forms. If it is not possible or practicable to have an online 
fillable form, you must use an accessible, fillable P D F. 

Fillable P D F Forms 

This guide provides an outline of what makes a P D F form fillable and 
accessible. It can help act as a reminder of the steps you might need to take 
when creating or fixing your form. 

 Add form fields. You can do this manually, or if you are starting with an 
accessible source document that you have properly formatted to become 
a fillable P D F form, Adobe can try to add form fields automatically. This 
feature is not always functional and accurate though, so you may still 
need to manually add or edit form fields for each question. 

 Each form field needs a visual label and tool tip for assistive technology to 
describe what the user needs to do with that form field 

 Use radio buttons and check boxes appropriately, and ensure they have a 
proper tool tip. Use radio buttons when only one option from a list can be 
selected. Use check boxes when more than one option from a list can be 
selected. 

 If the question is required, provide this information in the tool tip 

 Tag all elements of the form appropriately, for example paragraph text, 
headings, form fields, non-text elements 

 Ensure each form field has its own individual tag 

 Check and if necessary adjust reading order 

 Unless required, do not add time limits. If you must have a time limit, 
provide an option to save the form or extend the time 

Tips for User-Friendly Forms 

• Provide brief background information and / or instructions about what the 
form is for and how to complete it 

• Keep questions short and specific, ask one thing at a time 

• Avoid using asterisks (*) to indicate a required field 



50 

• Use standard entry fields for basic information such as dates, phone 
numbers, and emails 

• Provide direction for how the user needs to complete a question. For 
example, if the question has multiple choice options, indicate “select one” 
or “select all that apply”  

• Provide error messages to help users understand incorrect or missed 
information 

• Provide a confirmation note once the user has completed the form, and if 
applicable describe what to expect or any next steps  

For self-help instructions, check out Adobe’s guide to creating accessible 
and interactive forms 

For City staff, if you would like full training on how to achieve these 
requirements please contact the Accessibility Coordinator. 

P D F Fillable Form Accessibility Checklist 

• each question has form fields that are accurate and functional 

• all form fields are correctly tagged 

• all form fields contain understandable labels and descriptive tooltips 

• tooltips contain all formatting requirements 

• required fields are programmatically set and identified in the tooltips 

• the tab order of the form fields is logical 

• radio buttons and check boxes have be used and tagged appropriately, 
including appropriate tooltips 

• all standard PDF tagging requirements are met, such as paragraph and 
heading tags 

  

https://www.adobe.com/accessibility/products/acrobat/creating-accessible-forms.html
https://www.adobe.com/accessibility/products/acrobat/creating-accessible-forms.html
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Helpful Resources 

W3C PDF Techniques for WCAG 2.0 

 

If you would like to learn more about why document and web accessibility 
are important, check out the Perspectives Videos from W.3.C. 

 

https://www.w3.org/TR/WCAG20-TECHS/pdf
https://www.w3.org/WAI/perspective-videos/
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